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1 Overview
This document outlines best practices for using Ricoh Universal Printer
Drivers in the Microsoft® Print Server environment. It also details known
issues relating to the PCL6 UPD, PS UPD, and Print Server environments. It
is intended to be a guide for use in the planning and pre-deployment stages
of the Ricoh UPD. By reviewing this document thoroughly, you will greatly
increase the success rate of deploying the UPD in your server environment
and reduced the amount of client, server, and application issues that could
affect the performance of the UPD.

2 Description
Ricoh's Universal Print Driver provides a single intelligent advanced driver, which can
be used across your fleet of Multifunction Products and Laser Printers. The Universal
Print Driver lets you simplify printer support and lower management costs without
sacrificing the features important to your users.
PCL6 Driver for Universal Print White Paper Document Version 2.3.0. http://rfgesource.ricohusa.com/oracle/groups/public/documents/communication/rfg042289.pdf
PS Driver for Universal Print White Paper Document Version 2.3.0. http://rfgesource.ricohusa.com/oracle/groups/public/documents/communication/rfg042293.pdf

3 Support

Please verify that your model is supported by the Ricoh
UPD!
Non-Supported Models
Supported Models
If you do not have access to any links referenced throughout this document, you can
contact the Help Desk at 888-424-1573, option 3 or email at Solutions@Riochusa.com
For additional support, or to request updated information, you can contact the Help
Desk at 888-424-1573, option 3 or email at Solutions@Rioch-usa.com

3

4 Setup
Ricoh recommends applying hotfixes associated with the
Microsoft knowledge base (KB) articles listed below.
Hotfixes could greatly increase printing performance!

¾ Hotfixes that are directly associated with Windows Server that may affect UPD printing.
¾ KB article 982728 - ”Windows cannot connect to printer” error message when you try to create a
Point and Print connection to a remote printer from a Windows 7 or Windows Server 2008 R2based client computer
¾ KB article 983401 - A long delay occurs when you print a large file on a Windows 7 or Windows
Server 2008 R2-based computer
¾ KB article 2388142 - A computer that is running Windows 7 or Windows Server 2008 R2
intermittently cannot use a shared network printer to print
¾ KB article 919543 - The size of the EMF spool file may become very large when you print a
document that contains lots of raster data

Hotfixes that are directly associated with Microsoft Office that may
affect UPD printing.
¾ KB article 2121850 - A booklet layout setting does not work when
you print a multiple-page document in Windows 7 or in Windows
Server 2008 R2 if you use a printer driver that uses Unidrv.dll (After
the hotfix is applied, install any of the built-in MS-PS drivers in order
to overwrite the old pscript.dll. The new pscript.dll will be applied to
all of the existing PS queues including the PS UPD).
¾ KB article 2345342 - In Office 2010, you print a PowerPoint
presentation that is filled with images. In this situation, the operation
results in an oversized spooler file.
¾ Turn background printing on or off in PowerPoint http://office.microsoft.com/en-us/powerpoint-help/turn-backgroundprinting-on-or-off-HP003077099.aspx
When you turn Background printing on, you can continue to work as you
print. However, sometimes printing presentations that contain graphics can
drastically slow down the print process. If you are working on a
presentation that requires rapid response time from the printer, turn
Background printing off.
To turn background printing on or off, do the following:
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1. On the Tools menu, click Options, and then click the Print tab.
2. Under Printing options, select or clear the Background printing check
box.
¾ KB article 2553089 - Erratic print behavior when printing certain
Microsoft Power Point 2007 files. For example, Only 6 pages print
from a 10 page document. Charts and graphics are left out.
Offending command errors at the end of the jobs
¾ KB article 2592142 - Office 2010 printing errors with Calibri font
when printing through a Windows Server 2003 or 2008 print server

Hotfixes that are directly associated with Print Clusters that may
affect UPD printing.
¾ KB article 822553 - slow printing performance
¾ KB article 838337 - an issue where the recently installed printer is not
published
¾ KB article 835609 - an issue that results in the error “Unable to Install
Printer. The Print Processor does not exist.”
¾ KB article 976571 - Stability update for Windows Server 2008 R2
Failover Print Clusters

5 Installing the Ricoh PCL6/PS Universal Print Driver
Outlined below are several methods for installing product-specific drivers
and the Ricoh Universal Print Driver (UPD) to a cluster environment.
Ricoh recommends using the latest version of the Universal Print Driver, which
can be found at
http://ricohusa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx

Please review the Key Points to follow when creating TCP
/Port section below. This could greatly increase printing
performance!

Key points to follow when creating the TCP/IP Port
¾ Make sure the standard TCP/IP ports are created correctly (All default is
the only right way).
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¾ The SNMP status needs to be enabled and the community name needs
to match the setting on your printer.
¾ Enable Bidirectional Support. (Ricoh’s recommendation is to always
enable bidirectional support).
¾ The SNMP Status box will be unchecked when the port is created
while the printer is not on the network (staging) and the bidirectional
function is also disabled because of this. (Ricoh’s recommendation is
to always enable bidirectional support).
¾ Do not use existing ports created for other manufacturer's drivers.
(Settings like Bidirectional support may be disabled when doing so.
Create new ports for Ricoh devices and all other devices when you
install them).

5.1

Windows 7, Server 2008 R2

Step 1 Log in to Windows as an Administrator.
Step 2 Close any open applications.
Step 3 From the "Start" menu, select "Devices and Printers" > "Add a Printer".
Step 4 The "Add a Printer" dialogue will be displayed asking "What type of
printer do you want to install?" Select "Add a local printer".
Step 5 The "Choose a printer port" dialogue will be displayed. Create a new
"Standard TCP/IP Port" and click "Next".
Step 6 Enter the "Device" IP address and uncheck "Query the printer and
automatically select the driver to use". Click "Next".
Step 7 The "Install the printer driver" dialogue appears. Click "Have Disk".
Step 8 Browse to the folder containing the driver files (typically the CD-ROM or
an extracted archive downloaded from the website) and click "OK".
Step 9 Follow the rest of the Wizard's instructions to complete the installation.

5.2

Windows 2000, XP, 2003, Vista, 2008

Step 1 Log in to Windows as an Administrator.
Step 2 Close any open applications.
Step 3 Open "Printers and Faxes from the Start menu.
Step 4 Select "Add Printer".
Step 5 "Welcome to the Add Printer Wizard" is displayed. Click "Next >".
Step 6 The "Local or Network Printer" dialogue is displayed. Select "Local
printer attached to this computer" and click "Next >". Note: Do not enable
"Automatically detect and install my Plug and Play printer".
Step 7 The "Select a Printer Port" dialogue is displayed. Select "Create a new
port" > "Standard TCP/IP Port" as the port type and click "Next >".
Step 8 The "Add Standard TCP/IP Printer Port Wizard" is displayed. Click "Next
>".
Step 9 Enter the device IP address or hostname and click "Next >".
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Step 10 The "Install Printer Software" dialogue is displayed. Select "Have Disk".
Step 11 Browse to the folder containing the driver files (typically the CD-ROM or
an extracted archive downloaded from the website) and click "OK".
Step 12 Follow the rest of the Wizard's instructions to complete the installation.

5.3

Windows 7, Server 2008 R2 Using Group Policy

To deploy printer connections to users or computers by using Group Policy, you
must add the printer connections to a Group Policy object (GPO) as described in
the procedure. (Applies To: Windows 7,
Windows Server 2008 R2)
Step 1 Open Print Management (click Start, point to Administrative Tools,
and then click Print Management).
Step 2 In the left pane, click Print Servers, click the applicable print server, and
click Printers.
Step 3 In the center pane, right-click the applicable printer, and then click Deploy
with Group Policy.
Step 4 In the Deploy with Group Policy dialog box, click Browse, and then
choose or create a new GPO for storing the printer connections.
Step 5 Click OK.
Step 6 Specify whether to deploy the printer connections to users, or to
computers:
¾ To deploy to groups of computers so that all users of the computers can
access the printers, select the The computers that this GPO applies to
(per machine) check box.
¾ To deploy to groups of users so that the users can access the printers
from any computer they log onto, select the The users that this GPO
applies to (per user) check box.
Step
7
Click
Add.
Step 9 Repeat steps 3 through 6 to add the printer connection setting to another
GPO, if necessary.
Step 10 Click OK.
Note - For per-computer connections, Windows adds the printer connections
when the user logs on. For per-user connections, Windows adds the printer
connections during background policy refresh. If you remove
the
printer
connection settings from the GPO, Windows removes the corresponding printers
from the client computer during the next background policy refresh or user logon.

6 Driver Pre-Configuration With PDE
Many customers require company-wide default settings to be applied to all print
queues. Ricoh PCL6 drivers, PCL6 Universal Drivers and PS Universal Drivers
can be pre-configured using the Ricoh Printer Driver Editor PDE.
http://www.ricohusa.com/services_and_solutions/printerdrivereditor/printer_driver_editor.aspx
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Ricoh's Printer Driver Editor is a configuration tool for customizing printer
driver settings to fit the needs of different environments or company policies.
Customized print drivers can help support cost cutting or green initiatives by
restricting the use of certain functions or forcing default print driver settings, such
as black & white and duplex. The Printer Driver Editor provides Administrators or
IT personnel a self-service tool for creating custom driver settings, eliminating
the process of "requesting" driver changes.
You can use the Printer Driver Editor to customize the following printer driver
settings:
Changing the default value of the printer function
¾ You can change the factory default settings to new default settings for
each printer function to run the devices with customized setting values.
¾ The setting values can be changed from the default values on the printer
driver.
¾ The default setting you can change vary, depending on the type of device
or printer driver selected.
Locking the setting values of the printer function
¾ You can specify and lock setting values as default setting to prevent other
users from changing them on the printer driver.
¾ You can lock functions and setting values to fit your environment needs
and device uses.
¾ On the printer driver, the only setting values displayed are the default
values.
¾ The printer functions that you can lock/unlock vary depending on the type
of device you are using.
Hiding the setting value of the printer function
¾ You can specify to display or hide each of the setting values of the printer
function. (Only the setting values that are specified to "Display" are
shown)
¾ By hiding setting values you are able to restrict which settings can be
selected by users.
¾ Default values once set, are always visible
Displaying a popup dialog before print job is submitted
You can specify an optional function, for supported print drivers, to display a
popup dialog before printing starts. This dialog box is used to enter or confirm
authentication information. In addition, from [Select option:] you can select the
character strings to be displayed in the popup dialog.
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Please review the Post installation configuration and
bidirectional communication verification section below.
This could greatly increase printing performance!
Post installation configuration and bidirectional communication
verification.
Once the driver is installed and the queue is correctly configured, make sure that
the “Update Now” button is working. Deselect a few options and make sure they
are re-selected after “Update Now “ is clicked (see screen shots). Also, uncheck
“Automatically Update Printer Information”. The “Update Now “ button and the
“Automatically Update Printer Information” check box can be found under the
Accessories tab of the driver.
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7 Upgrading the Ricoh PCL6/PS Universal Print Driver to a
newer version
Ricoh recommends using the latest version of the Universal Print Driver, which
can be found at
http://ricohusa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx

Please review the Key points to follow when upgrading the
Ricoh PCL6/PS Universal Driver section below. This could
greatly increase printing performance!

Key points to follow when upgrading the Ricoh PCL6/PS Universal Print
Driver
¾ Do not use existing non Ricoh UPD queues created for other
manufacturer's drivers. (Create new queues for Ricoh devices and all
other devices when you install them). Don’t simply just click new driver to
update the queue to the Ricoh Universal Print Driver.
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¾ A characteristic of a printer that has a driver that was added to a preexisting non Ricoh UPD queue is the Print Processor may be set
incorrectly. Updating the driver via the “New Driver Button”, does not
change the print processor. The UPD PCL6, for example, has a Print
processor of winprint and a data type to RAW. The Print processor can be
found under the “Advanced” tab of the driver.
Upgrading the printer driver from an older version (excluding Ver.1.0.0.0)
to a newer version:
Note: If upgrading from an earlier version of the driver (Ver.1.1.0.0 - Ver.2.1.0.0),
the upgrade procedure might result in changes to the values configured for
settings such as orientation and layout.
Step 1 Open the "Printers" folder (or "Printers and Faxes") from the "Start" menu
or "Control Panel".
Step 2 Open the Properties of the printer to be upgraded.
Step 3 Advanced tab > New Driver button > Next button. (see screenshot)
Step 4 Select "Have Disk..." then browse to the folder containing the extracted
printer driver INF file. Click Open.
Step 5 Click OK and select the printer model. Click Next.
Step 6 Once the installation is complete, click Finish.
Step 7 Click OK to close the Printer Properties dialog box.
Step 8 Log the current user account off.
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Upgrading an x86 driver installed as an "Additional Driver" on an x64
system (and vice versa)
To replace an x86 print driver on an x64 server (and vice versa), the
following should be done:
Step 1 Open the Devices and Printers folder.
Step 2 Select any print queue and open the Print Server Properties window.
Step 3 Select the "Drivers" tab.
Step 4 Remove the x86 PCL/PS Printer driver files.
Step 5 Select "Remove driver only" and click OK.
Step 6 Click "Add" to install the new version of the x86 PCL/PS Printer driver.

8 Uninstalling the Ricoh PCL6/PS Universal Print Driver
Ricoh recommends using the latest version of the Universal Print Driver, which
can be found at :
http://ricohusa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx
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Windows 7, Server 2008 R2
Step 1 Log in to Windows as an Administrator.
Step 2 Close any open applications.
Step 3 Open the "Devices and Printers" folder from the "Start" menu.
Step 4 Delete the printer icon corresponding to the driver that is to be
uninstalled.
Step 5 File > Server Properties > Driver tab.
Step 6 Click the "Change Driver Settings" button.
Step 7 Select the driver to be uninstalled.
Step 8 Press the Delete key.
Step 9 Log the current user account off.
Windows Vista/Windows Server 2008
Step 1 Log in to Windows as an Administrator.
Step 2 Close any open applications.
Step 3 Click the "Printer" icon in the "Control Panel".
Step 4 Right-click anything in the folder and select "Run as administrator".
Step 5 Delete the printer icon corresponding to the driver that is to be
uninstalled.
Step 6 File > Server Properties > Driver tab.
Step 7 Select the driver to be uninstalled.
Step 8 Press the Delete key.
Step 9 Log the current user account off.
Windows XP/2k/Windows Server 2003
Step 1 Log in to Windows as an Administrator.
Step 2 Close any open applications.
Step 3 Click the "Printer" icon in the "Control Panel".
Step 4 Delete the printer icon corresponding to the driver that is to be
uninstalled.
Step 5 File > Server Properties > Driver tab.
Step 6 Select the driver to be uninstalled.
Step 7 Press the Delete key.
Step 8 Log the current user account off

9 Citrix Support
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The PCL6 driver for Universal Print is Citrix Ready:
http://www.citrix.com/ready/list/products?page=1&partnerPage=1&currentTab=pr
oduct&h_zzPartners_Partner=ricoh&sortBy=Alpha&partnerSortBy=Alpha&bc=h_
zzPartners_Partner#RICOH

Ricoh tests the PCL6 driver for Universal Print using the Citrix Printer Test Kits.
The kits and more
information are available at the following link:
http://www.citrix.com/English/partners/programs/thirdLevel.asp?programID=1681
660&tlID=1860442
The following methods of Citrix printing are available:
Not using a print server:
¾ Using the printer driver installed on the client: Auto-Create Printer (Native
Printer Driver)
¾ Using the printer driver installed on the client: Auto-Create Printer (Citrix
UPD)
¾ Using the printer driver installed on the XenApp server (local printer)
Using a print server:
¾ Using the client’s printer driver that is being shared from a print server:
Auto-Create Printer (Native
¾ Printer Driver)
¾ Using the client’s printer driver that is being shared from a print server:
Auto-Create Printer (Citrix
¾ UPD)
¾ Using a printer driver that is being shared by a print server using a policy
(Session Printer)
¾ Using a printer driver that is always shared by a print server
¾ PCL6 Driver for Universal Print version 2.3.0
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Note: Printing using Citrix UPD is not supported officially because the Citrix UPD
is not a driver created by Ricoh. The Citrix UPD uses EMF data. EMF data can
cause a variety of errors, depending on the application used to print.
Also, if a Citrix client has drivers that were installed via point and print, changes
made to the Citrix UPD settings might not take effect.
Limitation:
¾ The Citrix replication function, which replicates driver files - on another
server, is not supported. Please manually install the printer driver on each
server.
¾ Device Option Utility is not supported for use with any version of the PCL6
Driver for Universal Print
¾ Some driver settings from the client PC may not be inherited by the autocreated printer (such as Job Type settings, paper size, output tray, etc.).
This primarily occurs when the Citrix server is x64 and the client is x86 or
vice-versa.

10 Frequently Asked Questions
http://social.technet.microsoft.com/Forums/en-US/word/thread/493225be-2d1e4d14-b663-79ab99d339de/ - Word 2010: large file size sent to the printer. In
the printer options, you have to uncheck the option "enable advanced printing
features". It appears that the EMF spool file generated by Word 2010 can
become very large as soon as images are inserted in the document. By unchecking this option, it is a RAW file (smaller) that is sent to the printer. It should
be noted that the problem doesn't present with Word 2007 or 2003.
http://tscweb.custhelp.com/app/answers/detail/a_id/149333
Printing
from Microsoft Office 2010 results in a large spool file. A long delay
occurs when you print a large file on a Windows 7 or Windows Server 2008
R2-based computer.
https://tscweb.custhelp.com/app/answers/detail/a_id/122855 - [TA] Printing
1.3: Slow Printing. The Troubleshooting Assistant is a checklist consisting of
steps to take in order to troubleshoot, and if necessary, escalate a variety of
issues
https://tscweb.custhelp.com/app/answers/detail/a_id/14195 - Slow printing:
PostScript driver. Print speed can be affected by several things. This answer
lists some of the most common, with possible solutions.
https://tscweb.custhelp.com/app/answers/detail/a_id/141951 - Slow printing:
PCL driver. Print speed can be affected by several things. This answer lists
some of the most common, with possible solutions.
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11 Known Issues
[In General]
* To avoid problems in general, make sure that there is plenty of free disk space.
* With some applications (e.g. CorelDraw, Visio), complicated images may take a
long time to print when the "Graphics Mode" is "Vector". For faster printing,
choose "Raster"(Graphics Mode) on the "Print Quality" tab.
* If Graphics Mode is "Raster" then parts of the job might be output as blank
unprinted pages. If this occurs, try changing the resolution setting.

[OS/Windows Related Issues]
¾ Jobs should not be submitted to the queue while the Windows Print
Spooler is not running.
¾ In some cases, Separator pages might result in anomalies.
¾ Do not change the "Driver" setting in the Advanced tab.

[With Driver Settings]
[Copies] in [Setup] Tab:
When "Copies" is selected on the driver's "Setup" tab, the value may not be
reflected in the application print dialog box. Be sure to set the number of copies
only in the driver, not in the application.
[Staple] in [Setup] Tab:
Documents may not be stapled at the slant angle, even when you select "Top
Left Slant" or "Top Right Slant". In such a case, the document will be stapled
parallel to an edge of the paper.
[Booklet/Duplex] in [Setup] Tab:
Printing a large document in booklet, duplex or reverse order printing produce a
large temporary file. If you encounter an error when printing a large document in
booklet, try again after increasing the free area in system installed drive (e.g. C:).
[Edge to Edge Print] in [Print Quality] Tab, and [Non Reduction Booklet] in
[Setup] Tab:

16

The use of Edge to Edge Print with Non Reduction Booklet might result in
anomalies.
[Covers] in [Paper] Tab:
Use of a different Paper Source for the cover setting might result in a paper
mismatch error. This occurs if the cover is of a different paper size than the rest
of the document. This only happens if the cover is not blank and if the source tray
for the rest of the document is not "Auto Tray Select". As a workaround, change
the print settings so that any one of the above conditions are not met. Note:
"cover" = Front Cover, Back Cover or Chaptering Pages
[Graphics/Images]
¾ Use the "Printing Preferences > Print Quality > Image Processing > Best"
setting to clean up noise in printouts.
¾ When printing particular image data, it may appear noise on the printed
document. In this case, select [Best] in [Image Processing] on "Print
Quality" tab.
[Fonts/Texts]
Documents that contain fonts that are not installed on your computer might not
print correctly.
[CMYK used for Black and White Documents]
Black and White documents might be printed in full color (CMYK).
To ensure that the job prints using pure Black (K), please change the color mode
to "Black and White" or "Monochrome".
When selecting "Color" from "Color/ Black and White" setting in the "Setup" Tab,
black and white document may be printed as a color job, depending on
application or data. If you want to print a document in black and white, select
"Black and White" in "Color/ Black and White" setting.
[Help issues]
Resolution setting of Display is smaller than 800x600dpi, "Information Help"
window dialog may be oversized on the display. In this case, to close the
window, click "X" button on the right corner of the window dialog.
[Other issues]
An extra page is added to odd-paged duplex jobs. This blank page represents
the blank back side of the last page of the document. Under certain conditions,
this blank page might increment the printer’s page counter.
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To avoid potential problems, the "Printing Preferences > Paper > Reverse Order"
setting shouldn't be used with Duplex, Front cover, Back cover, Chaptering, or
Slip Sheets.
Upgrades with the New Driver button:
If a driver is upgraded using the New Driver button, the setting Automatically
Update Printer Information will be disabled.
Note: If there are multiple logical printers using the upgraded driver, only the
Automatically Update Printer Information setting of the logical printer used to
access the New Driver button will be disabled.

12 Fixes
Version 3.11.0.0
Fixed
¾ Various problems populating the driver UI via bidirectional communication.
¾ Use of the Paper Type "Inkjet Postcard" in the [Aficio 615C, Aficio MP
C1500, Aficio MP C1500SP, MP C1500, MP C1500SP, GS 106, SGC
1506, LD215cg, ISC615G] UI or Generic Model UI might result in the error
"The handle is invalid." being displayed by the client application.
¾ Registry entries remain on the system after the driver is removed.
Version 3.10.1.0
Fixed
¾ Dotted lines printed with the wrong spacing between dots.
¾ A bug in the scaling algorithm causing images to become distorted.
¾ Drivers installed via point and print might take a long time to open Printer
Properties.
¾ PCL XL error, job cancellation, or hang-up when printing dotted lines in
jobs from applications such as Microsoft Project 2010
¾ Switching to another printer in an application's print dialogue might take a
long time or cause the application to crash. This only affected PCL
Universal Print Driver's that had been installed over an older version using
the New Driver button.
¾ The driver version displayed by the driver's About button is incorrect. This
only affected PCL Universal Print Driver's that had been installed over an
older version using the New Driver button.
¾ The following product names are missing from the model selection
dropdown listbox (Printer Property > Accessories).
o SP 4400S
o SP 4410SF
o SP 4420SF
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Version 3.9.0.0
Fixed
¾ When printing, pop-up dialogues created by the Printer Driver Editor might
appear behind the application window. This issue only affects 32-bit
applications running on a 64-bit OS.
¾ PCL XL error "UnsupportedCharacterFormat" produced when printing
from IE9.
¾ The driver is unable to read the correct Accessories names from the
InfoPrint/Infotec .PSD files. This causes internal variable names to be
used instead.

Version 3.8.1.0
Fixed
- It takes a long time to open the Printing Preferences from within an application if
the driver was installed via cross-platform (x86 <-> x64) point and print.

Version 3.8.0.0
Fixed
¾ The document fails to print if the user account to log in to the OS contains
the following characters: []"<>&'
¾ The "Features" in the General tab are static.
¾ The Duplex setting will revert to default if the driver's properties are
opened from within an application.
¾ Newer dll files overwritten by older ones when a driver is installed in an
MSCS environment.

Version 3.7.0.0
Fixed
¾ Wording changes for the following settings: "2 sided" is used instead of
"Duplex". "Up to 8 digits" instead of "Up to 8 characters of numbers".
¾ When printing a booklet, watermark could not be printed on all pages.
¾ Updating to version 3.6.0.0 from any version between 1.1.0.0 and 1.3.0.0,
using the New Driver button, corrupts the Watermark list.
¾ Point and Print client's driver settings that are inherited from the server might
return to the default in about 5 minutes after the installation.
¾ Updating to version 3.6.0.0 from any version between 1.1.0.0 and 1.3.0.0,
using the New Driver button, results in the user unable to open the Printing
Preferences or Printer Properties window.
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¾ Unavailable options might be selected on the Accessories tab when the user
switches the model.

Version 3.6.0.0
Fixed
¾ Adobe Reader v7.x jobs containing data that is outside of the printable
area, trigger a driver bug that results in an application error and nothing
being printed.
¾ The driver was referencing part of driver settings and was retrieving
values. This has fixed a problem affecting the use of the driver with
Combit List & Label.
¾ Jobs containing objects that are outside the printable area might result in
an error 91 being recorded in the error log.
¾ The installation of an iPrint printer by a client in a TS session will cause
the Print Spooler on the Windows TS server to stop.
¾ If the iPrint "AllowUserPrinters" parameter is set to 2, it will take longer
than usual to open the Printing Preferences of drivers installed on iPrint
clients.
¾ When printing, pop-up dialogues created by the Printer Driver Editor might
appear behind the application window. This issue only affects 32-bit
applications running on a 64-bit OS.
Version 3.5.0.0
Fixed
After opening and closing Printing Preferences without closing Printer Properties
and then opening the Accessories tab and changing models, the device option
names are displayed using internal product codes.
Version 3.4.0.0
Fixed
¾ The "Automatically Update Printer Information" check box in the
Accessories tab will be unchecked after using the "New Driver" button to
upgrade from version 3.2.0.0 or earlier.
¾ Help cannot be opened if "Barrier-free Color Management" is enabled.
¾ Guests (users who are logged in anonymously) are able to see the Update
Now button. After the fix, the button will be grayed out for these users.
¾ After the driver is installed via point and print, it will take about 2 minutes
for the server's settings to be applied to the client. This only affected
Windows 7 and Vista point and print clients.
¾ The Japanese character set "Shift-JIS" might be applied to jobs that do
not contain any Japanese characters. This caused some extended-ASCII
to appear garbled or not print at all.
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¾ Watermarks cannot be added to the drivers that were installed by point
and print because the "Add" button is always grayed out.
¾ Local administrators were unable to add watermarks due to the bug.
¾ If the driver is run on an MUI version of Windows XP and Windows 2003,
the bottom part of the driver UI might be cut off.
Version 3.3.0.0
Fixed
¾ Color images printed in grayscale if "Print all text as black" is enabled.
¾ The Settings > Save/Load function doesn't backup/restore the "Chapter
Pages List".
¾ Switching to this driver from another driver in an application print dialogue,
takes a long time.
¾ Print performance is slow compared to other PCL drivers.
¾ If the driver is installed using the Windows Print Management console, an
error will be shown indicating that rc4man64.dl_ cannot be copied.
¾ "Print All text as black" has no effect on PDFs containing embedded fonts.
¾ Printing a PDF file that contains embedded fonts might result in the job
being canceled.
¾ Open type fonts can not be printed in bold.
Version 3.2.0.0
Fixed
¾ Print jobs submitted via Novell iPrint printers do not have a "Date / Time"
stamp.
¾ Cross-hatching patterns might be printed larger than shown on the screen.
This is known to affect Visio 2000.
¾ The print settings of the first Excel Worksheet are applied to all
subsequent worksheets in the job. This occurred even if "Increase autokeep settings for applications" was off.
¾ The front covers of center stapled booklets are pulled from the wrong tray.
Version 3.1.0.0
Fixed
¾ The Aficio MP C2050/C2550 UI's Advanced Options tab is missing User
Authentication settings.
¾ Note: C9020/C9025 and LD520C/LD525C same as Aficio MP C2050/C2550
¾ The Aficio MP 171/171F/171SPF UI's User Authentication settings are grayed
out if the Hard Disk is not installed.
¾ Note: 917/917F/917SPF and LD117/117F/117SPF same as Aficio MP
171/171F/171SPF
Version 3.0.0.0
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Fixed
If the duplex option is installed, the bypass tray is not available for selection as
an input tray. Only Aficio MP 2550/2550B/3350/3350B,Aficio MP
2550B/2550/2591/3350B/3350/3391,Aficio
MP
2550B/3350B,MP
2550/2550B/3350/3350B,9025/9025b/9033/9033b,LD425/LD425B/LD433/LD433
B is affected.

Version 2.3.0.0
Fixed
¾ Cannot open Print Properties or print via Novell iPrint if iprint.ini contains
"AllowUserPrinters = 2" (forces all printers to be installed as User
Printers).
¾ Jobs submitted to a Windows print server via "Print services for Unix"
might be printed in a smaller than expected font size.
¾ Printing of a PDF document containing embedded fonts might result in the
device throwing a PCL error and aborting the print job.
¾ Locked Print jobs with passwords of 5 - 8 characters in length are not
printed.

Version 2.0.0.0
Fixed
¾ The incorrect English used by the driver's default UI for installations on
unsupported local language systems.
¾ "2 hole" or "4 hole" punch does not work. It is known to affect some
models equipped with 2 hole or 4 hole punch units.
¾ Bi-direction communication on a cluster environment does not work,
preventing device accessory information from updating automatically.
Version 1.4.0.0
Fixed
Documents that include specific fonts are not printed. This is known to affect the
Univer55 and Futura fonts.

Version 1.3.0.0
Fixed
Some driver settings might have no effect if printing from Internet Explorer.

13 Non-Supported Models
No Fiery controllers
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Only models with GW controllers are supported.
The only non-GW
controller models that are supported are the 4410 and the 3510 in generic
mode.

14 Supported Models
Check the README file within the UPD download for a list of the most recent
supported models.
[Color Digital Copier]
Aficio MP C3500/C4500, Aficio MP C2000/C2500/C3000, MP C3500/C4500, MP
C2000/C2500/C3000, DSc 535/545, DSc520/525/530, C3535/4540, DSc520/525/530,
C3535/4540, C2020/C2525/C3030, LD435c/445c, LD420c/425c/430c, ISC 3535/4045,
ISC2020/2525/3030, Aficio MP C6000/C7500, Aficio MP
C4000/C5000/C4000G/C5000G, Aficio MP C2800/C3300/C2800G/C3300G, MP
C6000/C7500, MP C4000/C5000, MP C2800/C3300, C6055/C7570,
C4040/C5050/C4040G/C5050G, C2828/C3333/C2828G/C3333G, LD260c/LD275c,
LD540C/LD550C/LD540CG/LD550CG, LD528C/LD533C/LD528CG/LD533CG, MP
C6000SP/C7500SP, Aficio 3260C/Aficio Color 5560, Aficio MP C2050/C2550, Aficio MP
C2030/C2530, DSc460/CS555, MP C2050/C2550, MP C2030/C2530, C6045/SDC555,
C9020/C9025, C9020L, LD160c/LC155, LD520C/LD525C, LD520CL, ISC 4560/ISC
5560, Aficio 615C, Aficio MP C1500, MP C1500SP, GS 106, SGC 1506, LD215cg,
ISC615G, Aficio 3224C/3232C, DSc424/DSc432, C2410/C3210e, LD124c/LD132c,
ISC1024c/1032c, Aficio MP
C6000/C7500,MPC6000/C7500,C6055/C7570,LD260c/LD275c,MPC6000/C6000SP/C7
500/C7500SP,AficioMPC4000/C5000/C4000G/C5000G,AficioMPC4000/C5000,MPC40
00/C5000,C4040/C5050/C4040G/C5050G,LD540C/LD550C/LD540CG/LD550CG,Aficio
MP C2800/C3300/C2800G/C3300G,Aficio
MPC2800/C3300,MPC2800/C3300,C2828/C3333/C2828G/C3333G,LD528C/LD533C/L
D528CG/LD533CG,Aficio MP C2050/C2550,MP
C2050/C2550,C9020/C9025,LD520C/LD525C,Aficio MP C2030,Aficio MP
C2030/C2530,MP C2030/C2530,MP C2030,C9020L,LD520CL, Aficio MP
C6501SP/C7501SP,Aficio MP C7501SP,MP
C6501SP/C7501SP,C9065/C9075,LD365C/LD375C, Aficio MP
C4501/C4501A/C4501G/C4501AG/C5501/C5501A/C5501G/C5501AG,MP
C4501/C4501A/C5501/C5501A,C9145/C9145A/C9145G/C9145AG/C9155/C9155A/C91
55G/C9155AG,LD645C/LD645CA/LD645CG/LD645CAG/LD655C/LD655CA/LD655CG/
LD655CAG, Aficio MP C3001/C3001G/3501/3501G,MP
C3001/3501,C9130/C9130G/C9135/C9135G, LD630C/ LD630CG/LD635C/LD635CG,
Aficio MP C300/C300SR/C400/C400SR,MP C300/C300SR/
C400/C400SR,C230/C230SR/C240/C240SR,LD130C/LD130CSR/LD140C/LD140CSR,
Aficio MP C2051/C2551, MP C2051/C2551, DSc720/DSc725, C9120/C9125,
LD620C/LD625C, Aficio MP
C4502/C4502A/C4502G/C4502AG/C5502/C5502A/C5502G/C5502AG, MP
C4502/C4502A /C4502G/C4502AG/C5502/C5502A/C5502G/C5502AG, Aficio MP
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C3002/C3002G/C3502/C3502G, MP C3002/C3002G/C3502/C3502G, DSc930/DSc935,
Aficio MP C305SP/C305SPF, DSc530SP, MP C305SP/C305SPF
[Black and White Digital Copier]
Aficio MP 4001/5001/4001G/5001G,Aficio MP 4001/5001,MP 4001/5001,MP
4001/5001/4001G/5001G,9240/9250/9240G/9250G,LD140/LD150/LD140G/LD150G,Afi
cio MP 2851/3351,MP 2851/3351,9228/9233,LD528/LD533 Aficio MP
4000/4000B/5000/5000B, Aficio MP 2550/2550B/3350/3350B, Aficio MP
3500/4500/3590/4590, Aficio MP 2510/3010, MP 4000/4000B/5000/5000B, MP
2550/2550B/3350/3350B, MP 3500/4500, MP 2510/3010, DSm735e/745e,
DSm725e/730e, 9040/9040b/9050/9050b, 9025/9025b/9033/9033b, 8035e/8045e,
8025e/8030e, LD040/LD040B/LD050/LD050B, LD425/LD425B/LD433/LD433B,
LD335/345, LD325/330, Aficio MP 6000/6000 SP/7000/7000 SP/8000/8000 SP, Aficio
3035/3045, Aficio 3025/3030, Aficio MP 1600/2000, Aficio MP 161/161F/161SPF, MP
6000/6000 SP/7000/7000 SP/8000/8000 SP, MP 1600/2000, MP 161/161F/161SPF,
DSm735/745, DSm725/730, DSm716/721d, DSm416/416f/416pf,
8060/8060sp/8070/8070sp/8080/8080sp, 8035/8045, 8025/8030, 9016/9021d,
816/816mf, LD260/260sp/270/270sp/280/280sp, LD235/245, LD225/230, LD316/320d,
LD016/016f/016spf, IS2235/2245, IS2225/2230, IS2316/2320, IS2416/2416F/2416FPS,
Aficio MP 9000/1100/1350, Aficio MP 5500/6500/7500, MP 9000/1100/1350, MP
5500/6500/7500, DSm 790/7110/7135, m755/755sp/765/765sp/775/775sp,
8090/8110/8135, 8055/8055sp/8065/8065sp/8075/8075sp, LD 190/1110/1135, LD
255/265/275, IS 3090/3110/3135, IS 2255/2265/2275, Aficio 2051/2060/2075,
DSm651/660/675, 4051/4060/4075, LD151/160/175, IS2151/2160/2175, Aficio MP
2500/2500SP, MP 2500/2500SP, DSm625, 7025, LD125, IS2325, Aficio MP
171/171F/171SPF, MP 171/ 171F/171SPF, 917/917F/917SPF, LD117/117F/117SPF,
Aficio MP 6001/6001 SP/7001/7001 SP/8001/8001 SP/9001/9001 SP, MP 6001/6001
SP/7001/7001 SP/8001/8001 SP/9001/9001 SP, MP 6001/6001 SP/7001/7001
SP/8001/8001 SP/9001/9001 SP,9060/9060sp/9070/9070sp/9080/
9080sp/9090/9090sp, LD360/360sp/370/370sp/380/380sp/390/390sp, MP 6001/6001
SP/7001/7001 SP/8001/8001 SP/9001/9001 SP, Pro 906EX/1106EX/1356EX, Pro
907EX/1107EX/1357EX, Aficio MP 2550/2550B/3350/3350B,Aficio MP
2550B/2550/2591/3350B/3350/3391,Aficio MP 2550B/3350B, MP 2550/
2550B/3350/3350B,9025/9025b/9033/9033b,LD425/LD425B/LD433/LD433B,Aficio MP
4000/4000B/5000/5000B,Aficio MP 4000B/5000B, MP 4000/4000B/5000/5000B,
9040/9040b/9050/9050b,LD040/LD040B/LD050/LD050B,Aficio MP 6001/6001
SP/7001/7001 SP/8001/8001 SP/9001/9001 SP,Aficio MP 6001/7001/8001/9001,MP
6001/6001 SP/7001/7001 SP/8001/8001 SP/9001/9001 SP,
9060/9060sp/9070/9070sp/9080/9080sp
/9090/9090sp,LD360/360sp/370/370sp/380/380sp/390/390sp,MP
6001/7001/8001/9001,Aficio MP 171/171F/171SPF,Aficio MP
171F/171SPF,917/917F/917SPF,LD117/117F/117SPF,MP 171F/171SP, Aficio MP
201F/201SPF, MP 201F/201SPF, 920F/920SPF, LD220F/LD220SPF, Aficio SP
5200S/5210SF/5210SR, SP 5200S/5210SF/5210SR, Aficio MP 2352/2852/3352, Aficio
MP 2352SP/2852/2852SP/3352/3352SP, MP 2352SP/2852/2852SP/3352/3352SP,
DSm923sp/928/928sp/933/933sp, MP 2352/2852/3352, Aficio MP
4002/4002SP/5002/5002SP, MP 4002/4002SP/5002/5002SP, DSm940/DSm950, Aficio
SP 4400S, SP 4400S, Aficio SP 4410SF/4420SF, SP 4410SF/4420SF, Aficio MP
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301SP/301SPF, MP 301SP/301SPF, Aficio MP
6002/6002SP/7502/7502SP/9002/9002SP, MP
6002/6002SP/7502/7502SP/9002/9002SP
[Color Laser Printer]
Aficio SP C811DN, Aficio SP C410DN/C411DN, Aficio SP C400DN, SP C811DN, SP
C410DN/SP C411DN, SP C400DN, C7640nD, C7526dn/C7531dn, CLP240D,
CLP27DN/CLP31DN, LP440c, LP226cn/LP231cn, IPC4040DN, IPC 2525DN/IPC
3030DN, Aficio SP C420DN, SP C420DN, CLP131DN, LP331cn, Aficio
CL7200/CL7300, Aficio CL4000DN/CL4000HDN, Aficio CL3500N/CL3500DN,
7528n/7535hdn, C7528n/C7535n, C7425dn/C7425hdn, C7521n/C7521dn,
CLP128/CLP135, CLP26DN, CLP22, LP332c/LP335c, LP125cx/LP126cn,
LP222cn/LP221c/LP221cx, IPC 2832/IPC 3535e, IPC 2525/IPC 2525e, Aficio SP
C820DN/C821DN, SP C820DN/C821DN, C8140ND/C8150ND, CLP340D/CLP350D,
LP540C/LP550C , Aficio SP C420DN,SP C420DN,CLP131DN,LP331cn,Aficio SP
C820DN/C821DN,SP C820DN/C821DN,
C8140ND/C8150ND,CLP340D/CLP350D,LP540C/LP550C , Aficio SP
C430DN/C431DN, SP C430DN/C431DN, CLP37DN/CLP42DN, LP137CN/LP142CN,
Aficio SP C320DN, SP C320DN
[Black and White Printer]
Aficio SP 9100DN, Aficio SP 8100DN, Aficio SP 4100N/4110N, SP 9100DN, SP
8100DN, SP 4100N/4110N, P7675, P7245, P7035n/P7031n, MLP175n, MLP145,
MLP36n/MLP31n, LP275hdn, LP145n, LP136n/LP131n, Aficio SP 4100NL, SP 4100NL,
P7031nL, MLP31nL, LP131nL, Aficio SP 8200DN, Aficio AP610N, Aficio
AP410/AP410n, SP 8200DN, P7535n, P7527/P7527n, MLP150DN, MLP35n,
MLP28/MLP28n, LP150dn, LP135n, LP128/LP128n, Aficio SP 4210N, SP 4210N,
MLP37N, LP37N, Aficio AP900, P7575, MLP75n, LP175hdn, Aficio SP 8200DN,SP
8200DN,MLP150DN, LP150dn, Aficio SP 6330N,SP 6330N,MLP235n,LP235N, Aficio
SP 4310N,SP 4310N, Aficio SP 5200DN/5210DN, SP 5200DN/5210DN
For the latest fixes and supported models, Ricoh recommends using the latest
version of the Universal Print Driver, which can be found at
http://ricoh-usa.com/services_and_solutions/universalprintdriver/universal_print_driver.aspx
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